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AV Bros. Page Curl Pro 2.2 

for Windows and Mac OS X 
 
 

We are proud to introduce AV Bros. Page Curl Pro 2.2, 
the filter plug-in (8bf) for Adobe Photoshop and compatible 
hosts.  

 
AV Bros. Page Curl Pro 2.2 is targeted to help you create 

an extremely realistic and sophisticated page bend effect 
(Including the multi-bend option!), using two types of page 
bending: page curling and page folding. 

 
Thanks to the fact that the unrivalled engine of the plug-

in lets you not only bend the image, but also texturize it 
(using the bump maps), orient it in 3D space (including the 
perspective distortions) and obtain total control over the 
process of lighting the image (including the option of 
dropping internal shadows), we consider AV Bros. Page Curl 
Pro 2.2 as the multi-purpose plug-in that may be used not 
only as the page bender, but also as the Texturizer, Lighting 
lab, etc.  

 
The User Interface of AV Bros. Page Curl Pro 2.2 is 

extremely convenient and has some unique features that 
make your work with the plug-in both very efficient and 
pleasant at the same time.  

 
We are confident that we have developed not only an 

extremely professional, powerful and convenient product, 
which power will be obedient to you, but the product, which 
you have always dreamed about.  

AV Bros. Page Curl Pro 2.2 is the product that will 
increase not only your productivity, but your creativity as 
well. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

© 2005-2007 AV Bros. All rights reserved. 
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1 Introduction 

 
 
Introduction  

 
e recommend that you read this User Guide. Although AV Bros. Page 
Curl Pro 2.2 is quite easy to use, but it is really worth to invest some 

time in reading the manual for being able to use all of the product’s 
powerful capabilities for obtaining the best results quickly. We also 
recommend that you visit both the Gallery of AV Bros. Page Curl Pro 2.2 
and the Tutorials page on our web-site: http://www.avbros.com

 W

 
 

Installing 
 

AV Bros. Page Curl Pro 2.2 is a filter plug-in (8bf) for Adobe® Photoshop® 
and compatible hosts (Such as: Corel® Paint Shop™ Pro®, Adobe® 
Fireworks®, Corel® Photo Paint®, Ulead® PhotoImpact™ and others.) 
Please check the list of hosts on our web-site.  
 
Below you will find instructions on how to install AV Bros. Page Curl Pro 2.2 
in Adobe® Photoshop®.  
 

Note! Taking into account the fact that each host has its own 
required location where the plug-in must be installed, we 
recommend that you read the host’s manual on installation 
procedures for a plug-in. 
 

  
How to install AV Bros. Page Curl Pro 2.2 into Photoshop for Windows: 
 
• Close Photoshop. 
• Run the avpagecurlpro22.exe (avpagecurlpro22d.exe for the demo 

version) setup application. 
•  When you install the plug-in under Photoshop, the setup of the plug-in 

automatically determines the plug-in path. So, you just need to check it.
    But you can also specify the path manually by using the "Browse" 

button.  
• Click the Install button. 
• Start Photoshop. “AV Bros. Page Curl Pro 2.2” (“DEMO - AV Bros. 

Page Curl Pro 2.2” for demo version) will appear under 
Filter > AV Bros menu.

 

How to install AV Bros. Page Curl Pro 2.2 into Photoshop for Mac OS X: 
 
• Close Photoshop. 
•  Mount the avpagecurlpro22.dmg (avpagecurlpro22d.dmg for the 

demo version) disk image.
 •  Drag and drop the version of AV Bros. Page Curl Pro 2.2 that is suitable 

for your release of Photoshop to its plug-ins’ 	folder.
    (To learn more about the versions of AV Bros. Page Curl Pro 2.2, please 

        look through the “Read Me” document.) 
     • Start Photoshop. “AV Bros. Page Curl Pro 2.2” (“DEMO - AV Bros. 

    Page Curl Pro 2.2” for the demo version) will appear under the  
    Filter > AV Bros menu. 
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Customer Support 
 

AV Bros. provides our registered customers with professional, fast and free 
of charge technical support.  
If you have questions relating to AV Bros. Page Curl Pro 2.2, then please 
send them to support@avbros.com  
In order to quickly process your support request, please use the following 
text in the Subject line of your letter: AV Bros. support request! 
 

Note! To save yourself some time, please visit our Frequently 
Asked Questions (FAQ) page: http://www.avbros.com/faq.html
 
Note! We do NOT provide technical support relating to the image 
editing application (host.) Please, address such questions to the 
technical support staff of the host’s Developer. 
 
Note! For up to date information about the Customer Support, 
please visit our site: http://www.avbros.com
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Overview  
 

V Bros. Page Curl Pro 2.2 provides you with the possibility of being 
able to create almost any possible page bend effect, using two types of 

page bending: page curling (Page Curl) and page folding (Page Fold). 
Please review the complete List of Features of AV Bros. Page Curl Pro 2.2. 
But first, learn about the specific Terms that we have used in this User 
Guide. 

 A

 
 
 

Terms 
 

The Host: this is your image editing application. AV Bros. Page Curl Pro 
2.2 is the plug-in for your host. 
 
The Page is the object that you are about to bend (to curl or fold). The 
Page has two sides: the Front side and the Back side. 
 
An Active Layer of the current document is the layer with which you are 
working in your host. When you start the plug-in, you begin operate with 
the content of the Active Layer. 
 
The Bend is the result of either the page curling or the page folding 
process. 
 
The Multi-Bending: this is the term that we use to express the process of 
bending the page several times during one session of the plug-in. 
 
The Conflict Area of the page is the part of the page where the conflict 
occurs between the active bend and other bends and where the page 
cannot be bent. This conflict takes place when the current settings of the 
active bend cannot be applied without breaking the page’s surface.  
 
3D Space is a term of the 3D graphics that is used to describe the virtual 
area that emulates the real space around us. Unlike 2D graphics, where all 
objects have only width and height, in 3D space the objects also have 
depth. Using mathematical terms: if in 2D graphics you use the X and Y-
coordinates, then in 3D graphics you use the X, Y and Z-coordinates. The 
3D space is represented by the sphere, which we divided in two (2) 
hemispheres (the Front and the Back hemispheres) for the most convenient 
orienting the page in 3D space. 
 
The Central Point is the geometrical center of the page and is used as the 
center of the rotation of the page while orienting it in the 3D space. 
 
The Bump Map is a grayscale image that you can use for producing the 
3D-like effect of a texturized page. 
 
The Backdrop is an image that is placed beneath the Page in the Main 
Preview area and is solely used for indicating the transparency under the 
curled, folded or transparent parts of the Page. 
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List of Features 
 

• The ability to create both the turning page effect (Page Curl) and the 
folding page effect (Page Fold) (collectively – bends). 

• The Multi-bend option: the ability to create several bends within the 
single session of the plug-in. 

• The ability to orient the page in 3D space. 
• The ability to specify the desired level of the perspective while orienting 

in 3D space. 
• The ability to work with arbitrarily-shaped images (non-rectangular, with 

full or partial transparent areas, etc.)  
• The total control over the process of creating the surface for a curled or 

a folded page by adjusting the following parameters of the surface:  
- Angle, Level, Radius, Obliquity, Torsion, Direction and the Limit of the 

turn (for page curling).  
- Angle, Level, Folding Angle and Direction (for page folding).  

• Switching the direction (Upward or Downward) of page curling or folding.  
• Adjusting the opacity of the whole page.  
• Adjusting the cross-opacity of the page.  
• The ability to specify various contents for either side of the page:  

- Content from the active layer.  
- Solid color (custom color, host’s foreground or background colors).  
- Image from the file, which may be either tiled or resized to fit.  
- Content from any layer of the current document (This feature is 

available only for Adobe Photoshop 7.0 and higher.)  
• The ability to flip the content of either side of the page.  
• Swapping the content of the page’s sides.  
• The ability to choose between two lighting modes: the Simple and 

Advanced modes. 
• Adjusting the level of the shading in the Simple Lighting mode.  
• The total control over the process of lighting the page in the Advanced 

Lighting mode. This process includes: 
- Adding up to 25 light sources (Direct light sources.) for lighting both 

sides of the page. 
- Specifying the direction of either light source. 
- Specifying the parameters of the Diffuse Reflection of either light 

source, including the Color and Intensity of the Diffuse Reflection and 
the fact of its presence for either side of the page. 

- Specifying the parameters of the Specular Reflection of either light 
source, including the Color, Intensity and the Specular Exponent of 
the Specular Reflection and the fact of its presence for either side of 
the page.  

- Specifying the parameters of the Ambient Light, including its Color 
and Intensity for either side of the page. 

- Ambient Light Auto-Adjust option. 
- Rendering Inner Shadows with adjustable Opacity and Size. (Inner 

Shadows are dropped by any existed Light Source upon your choice.) 
• The ability to texturize either side of the page by using the grayscale 

images (called Bump Maps). As a Bump Map you can use either your 
document’s channels or any file. 

• The ability to adjust the existed Bump Map inside the plug-in. The 
following adjustments are available: Blur, Level, Flip Vertical and 
Horizontal. And you can also Invert (black to white and vice-versa) the 
existing Bump Map.   
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• The ability to make the bent part of the page to be outside the page’s 
initial boundary. 

• The ability to make the bent part of the page to be cut into the 
remaining part of the page. 

• The ability to create the “non-complete” page curling effect by adjusting 
the turn Limit.  

• The presence of a transparent area under the curled or folded part of the 
page. 

• Multi-level Undo option. 
• Supporting images in RGB, CMYK and Grayscale color modes.  
• Specifying the quality of the surface rendering, including the Auto Mode.  
• Exporting the result of the render as a PSD file. (Including current Color 

Profile provided by the host.)  
• Exporting the result of the render as a PNG file. (Only for documents in 

RGB and Grayscale color modes.) 
• Fast and high-quality preview.  
• Using various backdrops for the Main Preview area:  

- The standard checkerboard. 
- The custom solid color. 
- The content of the active layer of the current document. 
- The content of any layer of the current document. (This feature is 

available only for Adobe Photoshop 7.0 and higher.)  
• Saving and loading settings (cross-platform) of the plug-in.  
• The ability to record scripting parameters and be automated by them 

(Scripting-aware). 
•  Supporting the "Smart Filters" option of Photoshop CS3. 
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6 Work Area 

 
Work Area 
 

he work area of AV Bros. Page Curl Pro 2.2 consists of seven (7) 
primary and two (2) auxiliary windows. (All windows, except the Main 

window are also known as the palettes.) 
 T

For the most convenient operating with the plug-in, the last set position of 
either window (collectively - the Workspace) is remembered. 

 
Note! You must apply the plug-in if you want the Workspace to 
be remembered. 

 
Moreover, taking into account the fact that the plug-in has quite a few 
windows and there are cases when all necessary, at the moment, windows 
may not fit your screen, we have developed the unique (for user interfaces) 
solution that allows you to easily switch between various windows located 
at the same place: these are the buttons that you will see on the captions 
of those windows. 
 
The primary windows are the following: 
 
• Main window – for executing the basic operations, such as specifying the 

parameters of page curling/folding, primary previewing, etc.  
• Bends window – is necessary if you want to make several bends within 

single plug-in session.  
• 3D-Tranform window – for manipulating the page in 3D. 
• Three (3) Lighting windows – for control over the process of lighting the 

page. 
• Bump Mapping window – for manipulating the bump maps while 

texturizing the page. 
 
 
The auxiliary windows are the following: 
 
• Document Layers window – for choosing any layer of the current 

document either as a backdrop for the Main Preview area or as the 
content of the page’s side. 

• Document Channels window – for choosing any channel of the current 
document as the Bump Map. 

 
Note! Using the layer of the current document either as a 
backdrop for the Main Preview area or as the content of the 
page’s side is only available if you use Adobe Photoshop 7.0 (or 
higher) as the host. Therefore, the Document Layers window is 
available for operation only if you use AV Bros. Page Curl Pro 2.2 
with that host. 
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Main Window 

The Main window contains various controls that are used for executing the 
basic operations, such as specifying the parameters of page curling/folding, 
primary previewing, etc. The Main window consists of the following 
components:  

• Caption  
• Main Preview  
• Surface panel  
• Content panel  
• Executing area 
• Status bar 

Caption is used for dragging the Main window over the screen and 
contains three (3) menus (The Main menu, the Adjust menu and the 
Window menu.) and two (2) buttons - the “X” (Close) button and the “?”
(Help/About) button.  

Caption 

Main Preview 

Main Preview Area 

Auxiliary Panel 

Help Button Close Button Angle Slider 

Preview Area 
of

Surface Panel 

Turn Limit Slider

Executing Area

Front Side Content 
Controls 

  Flip Horizontal 

  Flip Vertical

  Preview Area 

Back Side Content 
Controls 

  Flip Horizontal 

  Flip Vertical

  Preview Area 

Status Bar 

Primary Windows 
Activation Buttons 

  Bends

  3D-Tranform

Lighting

Bump Mapping
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Main Preview consists of the Main Preview area and the auxiliary panel.  
The Main Preview area is used not only for displaying the effect created in 
the plug-in, but for orienting the page in the 3D space.  
The auxiliary panel contains the Options button, the HQ Preview button and 
the Backdrop Opacity slider. It is used for managing the Main Preview 
options. For the precise and convenient preview of the effect’s current 
stage, you can use the following options:  

• Type of the preview (the real-time or non-real-time preview). 
• The ability to enable the Internal Shadow auto-rendering. 
• Type of the backdrop for the Main Preview area (the checkerboard, the 

custom solid color, etc.). 
• The ability to show the clipping zone. 

  
 
Surface panel contains a number of controls that are used for creating the 
surface of the curled or folded page. These controls are:  
 

• Page Curl and Page Fold effects radio-buttons, for choosing the 
desired effect.  

• Direction radio-buttons for choosing the desired direction (Upward or 
Downward) of page curling or folding.  

• Preview area for showing and choosing the parts of the image, within 
which the current bend (Page Curl or Page Fold) is applied.  

• Controls for specifying the desired shape of the page’s surface. These 
controls are:  
- Angle (for both the Page Curl and the Page Fold effects).  
- Level (for both the Page Curl and the Page Fold effects).  
- Radius (only for the Page Curl effect).  
- Obliquity (only for the Page Curl effect).  
- Torsion (only for the Page Curl effect).  
- Folding Angle (only for the Page Fold effect). 
- Turn Limit (only for the Page Curl effect). There is also the special 

LCD-like display that shows the specified turn Limit. 
 
 
Content panel contains a number of controls that are used for operations 
with the content of either side of the page. These controls are:  
 

• Define buttons for specifying the type of the content for either side of 
the page.  

• The page’s Front Side and Back Side preview areas for displaying the 
defined content of the appropriate side.  

• Swap Content: Front/Back button for swapping the content of the 
page’s sides.  

• Flip Vertical and Flip Horizontal buttons. Four (4) buttons that let you 
flip the content of either page's side either vertically or horizontally.  

• Cross Opacity slider for specifying the level of the page’s cross 
opacity.  

• Page Opacity slider for adjusting the opacity of the entire page. 
 
  
Executing area contains four (4) buttons for activating other primary 
windows (Bends, 3D-Tranform, Bump Mapping and Lighting windows) and 
the controls, which are designed for executing the “output” operations. 
These controls are: 
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• Apply button.  
• Export button.  
• Cancel button.  
• Reset button.  
• Defaults button.  
• Quality button for specifying the quality of the rendering.  
• Render Quality Display, which shows you the specified level of the 

render quality.  

Status bar shows the succinct information about each control of the plug-
in as soon as you place the cursor over this control. 

Bends Window

The Bends window is one of the primary windows and contains the controls 
that let you add, delete and manipulate the bends. It consists of the 
following components: 

• Caption. 
• “Add”, “Add Copy”, 

“Delete”, “Up” and 
“Down” buttons. 

• Bends List. 

Caption 

Close Button 

Bends List 

Status Bar

Switch to Window… 

  3D-Tranform

Lighting

Bump Mapping

• Status bar. 

Caption is used for dragging the Bends window over the screen and 
contains four (4) buttons: the Close button and three (3) buttons for 
activating other primary windows, except the Main window. 

Add, Add Copy, etc. buttons are used for adding and deleting the bends 
to the List of the bends and changing the order of the bends (Up and 
Down) in this List. 

Bends List shows you (for further choosing) all existing bends (curls 
and/or folds) of the page. 

Status bar shows the succinct information about each control of this 
window as soon as you place the cursor over this control.
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3D Transform Window

The 3D Transform window is one of the primary windows and contains the 
controls that let you orient the page in 3D space and consists of the 
following components: 

Caption 

Close Button 

Flip Surface

Status Bar

Switch to Window… 

  Bends

Lighting

Bump Mapping

Display

3D Sphere

Spin Slider

• Caption. 
• 3D Sphere and the 

Spin slider. 
• Flip surface button. 
• Display. 
• Perspective Level 

slider. 
• Status bar. 

Caption is used for dragging the 3D Transform window over the screen 
and contains four (4) buttons: the Close button and three (3) buttons for 
activating other primary windows, except the Main window. 

3D Sphere with the Spin slider is the control that was specially designed 
for the most convenient orienting of the page on 3D hemisphere using the 
regular 2D mouse.  

Flip Surface button flips the page surface. This control, along with the 
one mentioned above, provides you with the full control over the process of 
orienting the page in 3D space. 

Display shows the Rotation angles values in X, Y and Z coordinates.  

Perspective Level slider lets you specify the desired level of the 
perspective for the page, oriented in 3D space. 

Status bar shows the succinct information about each control of this 
window as soon as you place the cursor over this control.

Lighting (Simple) Window

The Lighting (Simple) window is one of the primary windows and contains 
the controls that let you make fast adjustments of the shading and consists 
of the following components: 
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Caption 

Close Button 

Status Bar

Switch to Window… 

  Bends

3D-Tranform

Bump Mapping

• Caption. 
• Shading slider. 
• Switch to Advanced 

Mode button. 
• Status bar. 

Caption is used for dragging the Lighting (Simple) window over the screen 
and contains four (4) buttons: the Close button and three (3) buttons for 
activating other primary windows, except the Main window. 

Shading slider is used for fast adjustment of the shading effect on the 
page. 

Switch to Advanced Mode button switches from the Simple to the 
Advanced Lighting mode. 

Status bar shows the succinct information about each control of this 
window as soon as you place the cursor over this control. 

Lighting (Advanced) Window 

The Lighting (Advanced) window is 
one of the primary windows and 
contains the controls that let you 
obtain total control over the process 
of lighting the page and consists of 
the following components: 

Caption 

Close Button

Status Bar

Switch to Window… 

  Bends

3D-Tranform

Bump Mapping

Front and Back 
Hemispheres 

Light Sources

Light Sources list

 Active

Virtual Object 
Sphere 

Front / Back 
Hemisphere 

Switch 

Active Light 
Hemisphere 

• Caption. 
• Light Sources 

panel with several 
controls on it. 

• Active Light panel 
with a number of 
controls on it. 

• Switch to Simple 
Mode button. 

• Ambient Light 
button.

• Status bar. 
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Caption is used for dragging the Lighting (Advanced) window over the 
screen and contains four (4) buttons: the Close button and three (3) 
buttons for activating other primary windows, except the Main window. 

Light Source panel contains several controls for adding and deleting the 
light sources on the Light Sphere and choosing them afterwards. These 
controls are: 

• Front and Back Hemispheres special controls. 
• Light Sources list. 
• “Lock All” check-box.  

Active Light panel contains quite a few controls for manipulating the 
Active light. These manipulations include:  

• Position the Active Light on the Light Sphere.  
• Specifying the Active Light Diffuse and Specular Reflections. 
• Dropping the Inner Shadows.  

The controls that are located on the Active Light panel are the following: 
• Front and Back Hemispheres radio buttons. 
• Special control for position the Active Light source. 
• Intensity sliders for the Active Light Diffuse and Specular reflections. 
• Color swatches for Active Light Diffuse and Specular reflections.  
• Affect Front Side and Affect Back Side check-boxes for either type of 

Active Light reflections. 
• Specular Exponent for Active Light Specular reflection. 
• Opacity and Size sliders for the Active Light Inner Shadow. 
• Enable Active Light Inner Shadow check-box. 
• Render Active Light Inner Shadow button. 

Switch to Simple Mode button switches from the Advanced to the 
Simple Lighting mode. 

Ambient Light button activates the Ambient Light palette. 

Status bar shows the succinct information about each control of this 
window as soon as you place the cursor over this control. 

Ambient Light Window 

The Ambient Light window is one of the primary windows and contains the 
controls for adjusting the parameters of the Ambient Light and consists of 
the following components: 

• Caption. 
• Intensity sliders for  Front and 

Back sides.
• Color swatches of the Ambient 

Light for Front and Back sides 
of the page. 

• “Chain” button.  
• Status bar. 
• Auto-Adjustments check-

boxes for Front and Back sides 
of the page. 

Caption Close Button 

Status Bar

“Chain” button

Color Swatches 
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Caption is used for dragging the Ambient Light window over the screen 
and contains only one (1) button: the Close button. 

Intensity sliders are used for adjusting the intensity of the Ambient Light 
separately for the Front and Back side of the page. 

Color Swatches are used for specifying the desired color of the Ambient 
color by calling the Color Picker palette of the host. 

“Auto” check-boxes are used for enabling the Ambient Light’s Auto-
Adjustment option separately for the Front and Back side of the page. 

“Chain” button lets you change the parameters of the Ambient light 
simultaneously for both sides of the page. 

Status bar shows the succinct information about each control of this 
window as soon as you place the cursor over this control. 

Bump Mapping Window 

The Bump Mapping window is one of the primary windows and contains the 
controls for manipulating the Bump Maps for texturizing the page and 
consists of the following components: 

• Caption. 
• Blur sliders for the Bump 

Maps for the Front and 
Back sides. 

• Level sliders for the 
Bump Maps for the Front 
and Back sides. 

• Flip Horizontal and 
Vertical buttons for the 
Bump Maps for either 
side. 

• Invert the content of the 
Bump Map for either side. 

• Define buttons for either 
side.

• Preview areas for either 
side.

Caption

Close Button 

Status Bar

Switch to Window… 

 Bends

3D-Tranform

Lighting

Preview areas

Invert 

Flip Horizontal 

Flip Vertical 
• Status bar. 

Caption is used for dragging the Bump Mapping window over the screen 
and contains four (4) buttons: the Close button and three (3) buttons for 
activating other primary windows, except the Main window. 

Blur and Level sliders are used for adjusting the appropriate parameters 
of the Bump Maps for either side of the page. 
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Flip Horizontal and Vertical buttons are used for appropriate flipping of 
the content of either side’s Bump Map. 

Invert buttons are used for inverting (black to white or vice versa) the 
appropriate content of either side’s Bump Map. 

Define buttons let you get access to the menu for choosing the desired 
operations with Bump Map for either side of the page. 

Preview areas display the chosen Bump Map for either side of the page. 

Status bar shows the succinct information about each control of this 
window as soon as you place the cursor over this control.

Document Layers Window 

The Document Layers window is one of the auxiliary windows and contains 
the controls that are used for choosing any layer of the current document 
either as a backdrop for the Main Preview area or as the content of the 
page’s side. The Document Layers window is available for operation only if 
you use AV Bros. Page Curl 2.2 with Adobe Photoshop 7.0 (or higher) and 
consists of the following components: 

Caption is used for dragging the Document Layers window over the screen 
and contains two (2) buttons (the Close button and the Help button). 

Preview area is used for displaying the content of the selected 
document’s layer. 

List of Layers shows you (for further choosing) names of all existing 
layers of the current document and also the layer, named “Composite”, 
which represents the result view of the current document. (As if the 
document was flattened.) 

• Caption. 
• Preview area. 
• List of layers of the 

current document. 
• Ok and Cancel 

buttons. 

Caption Help Button Close Button 

Preview Area 

List of Layers 
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Document Channels Window 

The Document Channels window is another auxiliary window and contains 
the controls that are used for choosing any channel of the current 
document as the Bump Map. The Document Channels window consists of 
the following components: 

• Caption. 
• Preview area. 
• List of channels of the 

current document 
• Ok and Cancel buttons. 

Caption Help Button Close Button 

Preview Area

List of Channels  

Caption is used for dragging the Document Channels window over the 
screen and contains two (2) buttons (the Close button and the Help 
button). 

Preview area is used for displaying the content of the current document’s 
channel. 

List of Channels shows you (for further choosing) names of all existing 
channels of the current document.
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How to Use the Controls, Features and 
Commands 
 

elow you will find the descriptions of how to operate with the controls, 
features and commands of the plug-in. The descriptions are grouped 

by the location of controls (features or commands) in the Work Area (such 
as: Main window, Bends window, etc.) of the plug-in. Please, pay special 
attention to the “Details”, while reading the descriptions. 

 B

 
 
 

Main Window 
 
 

Main Preview  
 

Preview Area 
  

In AV Bros. Page Curl Pro 2.2 the Main 
Preview area can be used not only for 
displaying the current state of the 
effect, but for orienting the page in the 3D space as well.  
 
To perform the desired orientation of the page, click on the Main 
Preview area and then, without releasing the mouse button, start 
dragging. 
 

Details: 
- The possibility to orient the page in the 3D space is available 

only if the Real-Time Preview option is enabled. 
- When you orient the page right in the Main Preview area you 

adjust only two (2) parameters of three (3) of the page’s 
position in 3D space: the Altitude and the Azimuth. The Spin is 
the third parameter, and could be specified only in the 3D 
Transform palette.  

- By making the mouse double-click on the Main Preview area 
you can return the orientation of the page to a “2D look”, 
which has the following parameters: Azimuth is set to zero (0) 
degrees and the Altitude to 90 degrees. The Spin will not be 
changed. 

- For a more accurate orienting of the page, hold down the Ctrl 
(or Mac: Cmd) button and only then, click on the Main Preview 
area and start dragging the page. 

- While dragging the page you cannot turn it over or, in other 
words, you can see only one side of the page. To turn the 
page over, you should click the Flip Surface button in the 3D 
Transform palette. 
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Options Button 

  
The Options button lets you get access to the Main Preview options 
menu. These options are: 
 

• Real-time Preview. 
• Shadow Auto Rendering. 
• Show Clipping Zone. 
• Choose Clipping Zone Color. 
• Use Solid Color as Backdrop. 
• Choose Solid Color for Backdrop. 
• Use Current Layer as Backdrop.  

  
Click the Option button and the menu with options will appear. Then 
choose the option that you need.   
 

Option: Real-Time Preview 
 
This feature lets you choose between the real-time or non-real-
time previewing of changes that you have made in the plug-in. 
All changes are displayed in the Main Preview area. To enable the 
Real-Time Preview option, do one of the following:  

- Click the Options button on the auxiliary panel of the 
Main Preview and then select the Real-Time Preview 
menu item. 

- Right-click (or Mac: Ctrl+click) in the Main Preview 
area and then select the Real-Time Preview menu item. 

 
Details: 
- By default, the Real-Time preview option is disabled. 
- A check mark indicates that the Real-Time Preview option 

is selected. 
- To cancel the Real-Time Preview option and switch back 

to the Non-Real-Time preview, just select this menu item 
one more time. (The check mark will disappear.) 

- If the Real-Time Preview option is enabled, then the 
result of the rendering will be dynamically updated each 
time you make any changes. 

- If the Real-Time Preview option is disabled, then the 
result of the rendering will be displayed after releasing 
the mouse’s button or finishing editing the edit-boxes. 

- Irregardless of what type of the preview is in use, the 
result of the rendering is initially displaying in the draft 
mode. To preview the result of the render in high-quality 
mode, use the HQ Preview button. 

- When the Real-Time Preview option is in use, you can 
orient the page in 3D space right in the Main Preview 
area. Just click on the image and then drag it. 

- You can increase the accuracy while orienting the image 
in 3D space directly in the Main Preview area. To do that, 
hold down the Ctrl (Mac: Cmd) button and only then 
click the image and drag it. 

- If you want to see the internal shadow rendered in the 
Main Preview, but the Shadow Auto Rendering option is 
disabled, then you will need to click the Render Shadow 
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button or use the HQ Preview (High Quality Preview) 
button. (Even if the Real-Time Preview option is enabled.)  

- The plug-in remembers the last used settings. 
- We recommend that you disable the Real-Time Preview 

option for slow computers. 

Option: Shadow Auto Rendering  

This feature lets you choose between the real-time or non-real-
time previewing of the process of rendering the inner shadow. To 
enable the Shadow Auto Rendering option, do one of the 
following:  

- Click the Options button on the auxiliary panel of the 
Main Preview and then select the Shadow Auto Rendering 
menu item. 

- Right-click (or Mac: Ctrl+click) in the Main Preview 
area and then select the Shadow Auto Rendering menu 
item. 

Details:
- By default, the Shadow Auto Rendering option is 

disabled. 
- A check mark indicates that the Shadow Auto Rendering 

option is enabled. 
- To disable the Shadow Auto Rendering option, just select 

this menu item one more time. (The check mark will 
disappear.) 

- If both the Shadow Auto Rendering option and the Real-
Time Preview option are enabled, then the internal 
shadow will be dynamically rendered each time you make 
any changes. 

- If the Shadow Auto Rendering option is enabled, but the 
Real-Time Preview option is disabled, then you will see 
the result or the internal shadow’s render only after 
releasing the mouse’s button or finishing editing the edit-
boxes. 

- If the Shadow Auto Rendering option is disabled, then the 
result of the internal shadow’s render will be displayed 
only after clicking either the Render Shadow button or 
the HQ Preview (High Quality Preview) button. 
(Regardless of the state of the Real-Time Preview 
option.) 

- The plug-in remembers the last used settings. 
- We recommend that you disable the Shadow Auto 

Rendering option for slow 
computers. 

Option: Show Clipping Zone  

The ability to show the Clipping 
Zone lets you check the position of 
the curled or folded image within 
the bounds with which your host 
provides the active layer.  

The Clipping Zone.
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To enable this feature, do one of the following: 
- Click the Option button on the auxiliary panel of the Main 

Preview and then, select the Show Clipping Zone menu 
item. 

- Right-click (or Mac: Ctrl+click) in the Main Preview 
area and then, select the Show Clipping Zone menu item. 

Details:
- A check mark indicates that the Show Clipping Zone 

option is enabled. 
- The Clipping Zone shows the bounds with which your host 

provides the active layer, irregardless of the presence of 
the selection in the active layer. 

Option: Choose Clipping Zone Color  

This option lets you choose the Clipping Zone color depending on 
your image for the most convenient work.  
To choose the color, do one of the following: 

- Click the Option button on the auxiliary panel of the Main 
Preview and then, select the Choose Clipping Zone Color 
menu item. 

- Right-click (or Mac: Ctrl+click) in the Main Preview 
area and then, select the Choose Clipping Zone Color 
menu item. 

Details:
- The pink color is used for showing the Clipping Zone by 

default.
- The host’s color picker palette will appear as soon as you 

select the Choose Clipping Zone Color menu item. You 
should use this palette for choosing the desired color. 

Using the Backdrop  

The ability to specify the various contents as a backdrop is the 
amazing feature that lets you accurately position your curled or 
folded image within the bounds of the document with which you 
are working.  
In AV Bros. Page Curl Pro 2.2 you 
can choose the type of the backdrop 
for the Main Preview area. The 
following backdrops are available:  

- The standard checkerboard. 
- The customizable solid 

color.
- The content of the active 

layer of the current 
document. 

- The content of any layer of 
the current document. (This 
feature is available only for 
Adobe Photoshop 7.0 and 
higher.  

The content of the 
active layer is used 
as the backdrop.



 AV Bros. Page Curl Pro 2.2  
 User Guide 
 

20 Controls, Features and Commands 

 
To specify the desired backdrop do one of the following:  

- Click the Option button on the auxiliary panel of the Main 
Preview and then select the desired menu item related to 
the Backdrop. 

- Right-click (or Mac: Ctrl+click) in the Main Preview 
area and then select the desired menu item related to the 
Backdrop.  

 
Details:  
- Any type of the backdrop that is used in AV Bros Page 

Curl Pro 2.2 is used just for previewing purposes and will 
not be rendered after applying the plug-in. 

- The standard checkerboard is used as a backdrop by 
default or if all other backdrop options are disabled. 

- If you enable the Use Solid Color as Backdrop option, 
then AV Bros Page Curl Pro 2.2 takes the last used, for 
the same operation, color. Only if you select this option 
for the very first time, then the plug-in uses a white color 
as the backdrop. 

- To let you choose the desired color for the backdrop, the 
plug-in calls your host’s color picker as soon as you select 
the Choose Solid Color for Backdrop menu item.   

- If you use a layer as a backdrop and begin orienting the 
page in 3D space, then the usefulness of the current 
backdrop may be decreased. 

- If the layer that you use as a backdrop contains the 
transparent (full or partial) areas, then you should take 
into account the fact that the backdrop blends into the 
white color. 

- Even if you use Adobe Photoshop 7.0 and higher, you 
should have more than one layer in your document to 
enable the Use Document Layer as the Backdrop option. 
Otherwise, only the Use Current layer as backdrop option 
will be enabled. 

- To make the process of choosing the document’s layers 
for the backdrop more convenient – the special Document 
Layers Window will appear as soon as you select the 
Choose Document Layer for Backdrop menu item.  

- A check mark indicates which one of the particular 
options is selected. 

- If you want the last used settings to be remembered, you 
should apply the plug-in. 

 
 

 
HQ Preview Button 

  
Click the HQ (High Quality) Preview button to 
perform the high-quality rendering of the 
effect’s current stage and display the result in 
the Main Preview area. 

 
Details:  
- Any changes that you have made in the plug-in, such as 

adjusted the control, clicked a button, etc., will reset the HQ 
preview back to the draft mode. Then click the button again, if 
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you want to preview the new stage of the effect rendered in 
high quality mode. 

 
 
 

Backdrop Opacity Slider 
 

The Backdrop Opacity feature lets you adjust 
the opacity of the backdrop, which you have 
chosen for the Main Preview area.  
Drag the Backdrop Opacity slider to specify 
the opacity of the backdrop. 

 
Details:  
- The range of the Opacity’s values is between 0 and 100%. 
- The Backdrop Opacity slider is only enabled if the content of 

the layer is used as a backdrop. 
- Decreasing the opacity of the backdrop results in the backdrop 

blending into the white color. 
- By default, the opacity of the backdrop is set to 50%. 
 

 
 
 
 
 
 
 

Surface Panel 
 

Page Curl and Page Fold Effects Radio-buttons  
      
These controls let you specify which one of the 
effects you will apply to the active bend: the Page 
Curl or Page Fold.  
 
For choosing the desired effect, with which the plug-
in will operate, click the appropriate radio-button. 

 
 
 

Directions Radio-buttons  
      

These controls let you specify the desired direction 
of the active bending (page curling or folding). Use 
the Up radio-button for bending the page upward 
and the Down radio-button for curling or folding the 
page downward.  
 
For choosing the desired direction, just click the appropriate radio-
button. 
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Level  

LevelAngleFor Page Curl, the Level 
control lets you specify 
the position of the initial 
boundary of the area 
within which the current 
Page Curl effect will be 
applied. The shape of this 
area depends on the 
settings of this effect. 

For Page Fold, the Level 
control lets you specify the 
position of the folding line 
or, in other words, the line, 
along which the page will 
be folded.  

To specify the desired value of the Level, drag the Level slider or enter 
the appropriate value into the edit box. 

Details:
- The range of the Level’s values is between 0 and 100%. The 

Level set to zero (0) means that any adjustments, related to 
the surface, that you made will not affect the page. The Level 
set to 100% means that the entire page will be affected. 

- If there are several bends on the page, then the active bend 
may oust the bends that are beneath it in the bends’ list. 

Angle  

The Angle control lets you specify the angle on which will be rotated 
the initial boundary (for Page Curl) or folding line (for Page Fold). 

To specify the desired value of the Angle, drag the Angle slider or 
enter the appropriate value into the edit box. 

Details:
- The range of the Angle’s values is between 0 and 360 degrees. 
- The adjusting of Angle of the active bend (if there are several 

bends on the page) may affect (oust) the bends that are 
beneath it in the bends’ list. 

Radius  

This control lets you specify the desired value of the radius of the 
page’s curl. The feature is enabled only if you are operating with the 
Page Curl effect.  
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Drag the Radius slider to 
specify the desired value of 
the Radius or enter this value 
into the edit box.  

Details:
- The range of the 

Radius’ values is 
between 2 pixels and 
6200 pixels. 

- Despite the fact that 
you specify the Radius 
in absolute values 
(pixels), the engine of AV Bros. Page Curl Pro 2.2 is also 
calculate the relative value of this parameter. Moreover, the 
relative value is used by default. This is specially made to 
provide you with the possibility to apply the plug-in with the 
same settings to images that have different dimensions, but 
the same, or almost the same, aspect ratio (e.g. the original 
image and its thumbnail.) and obtain a similar look of the 
effect. But, if you need that the plug-in be applied with 
absolute value of the radius, then, of course, you can do it 
with ease – just go under Main menu and choose Load settings 
(absolute) or Reset Settings to Last Used (absolute) menu 
items. Please review the images below to see what the 
difference is between using absolute and relative values of the 
Radius. 

Radius

 Reapplied 
with relative

settings 

Reapplied   
with absolute

settings 
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Obliquity

Obliquity: 0

Obliquity: 100%

This control lets you specify the 
desired value of the obliquity while 
curling the page. The feature is 
enabled only if you are operating 
with the Page Curl effect.  

Drag the Obliquity slider to specify 
the desired value of the Obliquity or 
enter this value into the edit box.  

Details:
- The range of the Obliquity’s 

values is between -100% and 
100%. The Obliquity set to 
zero (0) means that the page 
has the cylindrical look in its 
curled part. The Obliquity set 
to either 100% or -100% 
means that the page has the 
conical look in its curled part, 
just the direction of that cone 
is variable 
depending on the 
sign of the 
Obliquity’s value. 

Torsion  

This control lets you specify 
the desired value of the 
torsion while curling the 
page. The feature is 
enabled only if you are 
operating with the Page 
Curl effect.  

Torsion: 100%

Drag the Torsion slider to 
specify the desired value of 
the Torsion or enter this 
value into the edit box.  

Details:
- The range of the Torsion’s values is between 0 and 100%. The 

greater the value you specify the more the torsion is obtained 
on the curled page. 

- When you use the Torsion option and its value is other than 
zero (0), then the look of the torsion effect depends not only 
on the Torsion’s value, but on the value of the Obliquity as 
well. If the Obliquity is set to zero (0), then it does not affect 
the torsion effect, but the higher the value of the Obliquity the 
higher is its influence on the torsion effect.
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Limit  

This control lets you specify the 
desired value of the curling limit. 
The feature is enabled only if 
you are operating with the Page 
Curl effect. 

Limit: Off

Limit: 180o

Limit: 90o

To enable the Limit control, 
select the Limit check-box. Then 
drag the Limit slider to specify 
the desired value of the Limit or 
enter this value into the edit 
box.

Details:
- The range of the 

Limit’s values is 
between 0 and 
359’999 degrees. 

- This unique 
control lets you 
create the “non-
complete” page 
curl effect and as 
a result there is 
the possibility to 
apply the page curl effect several times to the part of the 
page, which you have chosen for the initial curling.  

- Along with the regular edit box where you can see the 
specified value of the parameter, the Limit control has the 
special LCD-like display that shows you the value of the Limit 
in a more convenient way: the number of full turns plus the 
remainder. E.g. If you specify the Limit as 740 degree, then it 
will be shown as: Full Turns: 2; Remainder: 20 

Folding Angle  

This control lets you specify 
the desired value of the 
folding angle while folding 
the page. The feature is 
enabled only if you are 
operating with the Page 
Fold effect.  

Folding Angle

Drag the Folding Angle 
slider to specify the desired v
value into the edit box.  

alue of the Folding Angle or enter this 
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Details:
- The range of the Folding Angle’s values is between 0 and 180 

degrees. The greater the value you specify, the greater the 
fold on the page. 

- When you fold the page and the Folding Angle’s value is less 
than 90 degrees, then, in some cases, the look of the folded 
page may not change if you change the Direction (e.g. from 
Up to Down). This strange situation, at first glance, occurs 
when both the altitude of the light source(s) and the altitude 
of the page’s position in 3D space coincide and both are 90 
degrees. But as soon as you change either of the altitudes, 
then this “strange” visual effect will disappear.

Preview Area 

The active bend

Conflict area

Another bend

The Preview area on the Surface panel is used 
for displaying the location of the 
bends on the page and for selecting 
the bend with which you want to 
operate. (Of course, you can also select the 
desired bend in the Bends palette.) 

For selecting the desired bend just make a 
single-click on this bend right on the Preview 
area. 

Details:
- The active bend (Page Curl and/or 

Fold) is indicated by the semi-
transparent green-colored overlay, 
regardless of the number of the 
bends on the page. Any other bend (if present) is indicated by 
the semi-transparent blue-colored overlay. 

- The shape of the area that is covered by the semi-transparent 
overlay (green- or blue-colored) is the variable polygon 
(depended on the settings) for Page Curl and is always the 
thin line for Page Fold. 

- If there is the conflict area on the page (See Terms.), then this 
area is indicated by the semi-transparent red-colored overlay. 

- You cannot select the bend, which is completely in the conflict 
area. 

- Taking into account the fact that the conflict between bends 
occurs because of the active bend settings, selecting another 
bend may “resolve” the conflict. 
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Content Panel 

 
Define Buttons  

  
There are two (2) Define buttons in the plug-in. The 
first button allows access to the menu for operating 
with the content of the Front side of the page. The second button has 
the same function, but only for the Back side of the page.  
 
The following options are available for operation with the content:  

- “From Active Layer” option: the image from the active 
layer will be used as the content of the appropriate side of the 
page. 

- “Foreground, Background and Custom Color” options: 
the appropriate side of the page will be filled with the 
foreground, background or custom color, specified by the 
host’s color picker. 

- “From File – Tile” option: the appropriate side of the page 
will be tiled with the image from file. The desired file should be 
chosen with the help of the standard open file dialog. 

- “From File – Resize to Fit” option: the appropriate side of 
the page will be filled with the image (The image will be 
resized to fit the page’s dimensions.) from file. The desired file 
should be chosen with the help of the standard open file 
dialog. 

- “Flip Horizontal” and “Flip Vertical” options: the content 
of the page’s side will be flipped the appropriate way. 
 

If you use the plug-in with Adobe Photoshop 7.0 and higher, then 
additional options are available for operation with the content:  

- “From Document Layer” option: the image from either 
layer of the current document will be used as the content of 
the appropriate side of the page. 

- “From Document Layer – Trim by Transparency and 
Tile” option: the image from either layer of the current 
document will be used as the content of the appropriate side 
of the page, but for accomplishing this operation this image 
will be trimmed by its transparency and then, tiled. 

- “From Document Layer – Trim by Transparency and 
Resize to Fit” option: the image from either layer of the 
current document will be used as the content of the 
appropriate side of the page, but for accomplishing this 
operation this image will be trimmed by its transparency and 
then, resized to fit. 

 
 
Click the Define button and the menu with options will appear. Then 
choose the desired option.  
 

Details:  
- The plug-in remembers the chosen option. For example, you 

have chosen the “Background Color” option as the content of 
the page’s side. This means that if you apply the plug-in and 
then start it again, the plug-in will take the background color 
of your host as the content of the appropriate page’s side, 
even if you have changed this background color. The plug-in 
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just knows that it should be the “background color” 
irregardless what color it is. 

- If you use any (from three) option that lets you operate with 
the document’s layer other than the active layer (These 
features are available only if you use the plug-in with Adobe 
Photoshop 7.0 and higher.) then, the bounding rectangle of 
the content of the layer to which the plug-in was initially 
called, is used for trimming any layer’s content that you will 
use in the future. (Within the current session of the plug-in, of 
course.)  

- If you applied the plug-in to some document and then, you call 
it again to another document, (Or to the same document, but 
that has been changed.) but the content that was used for 
either side of the page does not exist any more, (Because it is 
another or changed document, or because it was the file used 
as the content and this file does not exist any more.) then the 
plug-in will take the host’s background color as the content of 
the side, which former content cannot be found.   

Cross Opacity

This control lets you 
adjust the visibility f
of the page’s back side 
through the front side 
and vice versa. That lets 
you emulate the 
situation from real life, 
when the back side of 
the page is slightly 
visible through the front 
side and vice versa. 
(But, this page may NOT 
be transparent by itself.)  

Cross Opacity: 50%
Page Opacity: 100% 

Drag the Cross Opacity 
slider to specify the c
opacity of the page or 
enter the desired valu
into the edit box.  

Details:
- The range of the Cross Opacity’s values is between 0 and 

100%. 
- If you specify the value of Cross Opacity to zero (0), then the 

page looks identical from either side. 
- If you specify the value of Cross Opacity to 100%, then you 

cannot see the content of the back side of the page through 
the front side and vice versa. 
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Page Opacity  

This control lets you 
adjust the opacity of the 
entire page.  

Drag the Page Opacity 
slider to specify the 
opacity of the page or 
enter the desired value 
into the edit box.  

Details:
- The range of the 

Opacity’s values 
is between 0 and 
100%. 

- You cannot see 
the content of 
the back side of 
the page through 
the front side and vice versa, (See 
the Cross Opacity.) regardless of 
the value of the page’s opacity.    

Cross Opacity: 100%
Page Opacity: 50% 

Swap Content: Front/Back Button 

This control lets you swap the content of 
the page’s sides.  

Click the “Swap Content Front/Back” button to perform the swap 
operation. 

Flip Vertical and Flip Horizontal Buttons 

Flip Vertical

Flip Horizontal

These four (4) buttons let you flip the 
content of either side of the page. There are 
two (2) buttons for each page’s side: one 
performs Flip Vertical operation and the 
second – Flip Horizontal operation.  

Click the appropriate button to perform the 
flip operation for the content of the desired 
side of the page.  

Details:
- If the solid color is used as the content of the page’s side, then 

the flip buttons related to this side are disabled. 
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Executing Area 

 
Apply Button  
 
Use the Apply button when you are satisfied 
with the effect created inside the plug-in and 
you want to see it inside your host. 

 
 
 

Export Button  
 
By clicking the Export button you obtain access 
to the Export menu.  
Then you can choose either "Render Result to 
PSD" or the "Render Result to PNG" menu item.  

 
Details:  
- Whether you export the result of the rendering to PSD or PNG 

it exports irregardless of the dimensions of the document that 
you are working with. This fact lets you remain calm about 
whether the bended image is bigger than the working 
document. Even if it is, the created effect will be exported “as 
is”, without trimming its prominent, outside the canvas, parts. 

- Choosing either of the Export options does not close the plug-
in. 

- The Export to PNG option is enabled only if the document is in 
RGB or Grayscale modes and is disabled if it is in CMYK color 
mode. 

- While the PSD file in which you export the result of the 
rendering contains both the resolution and the profiles of the 
document, the PNG file contains only the resolution of the 
document. 

 
 
 

Quality Button  
 
By clicking the Quality button you 
obtain access to the render quality 
menu.  
 
Then you can choose one of the render quality levels (High, Normal, 
Low or Draft), or the Auto mode. (In this case the plug-in 
automatically specifies the level of the render quality.)  
The LCD-like display, located near the button, shows you the specified 
level of the render quality.  

 
Details:  
- The higher the level of the rendering quality, the longer the 

time for rendering. We recommend that you find the 
compromise between the render quality and time for 
rendering. (Just take into account the fact that the time for 
rendering also depends on the image size and the complexity 
of the effect.) A good solution for finding that compromise is 
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using the Auto mode of the render quality. In this case the 
plug-in adaptively specifies the level of the render quality: the 
smaller your image, the higher the quality of the rendering 
and the larger the image, the lower the quality of the 
rendering.  

 
 

 
Cancel, Reset and Defaults Buttons 
  
The Cancel button closes the plug-in window and 
cancels all of your recent activity in the plug-in.  
 
The Reset button cancels all changes (without 
closing the plug-in window) to the values you had 
prior to your changes.  
 
The Defaults button cancels all changes (without closing the plug-in 
window) to the values that were specified as default values by AV 
Bros. 

 
 
 

Bends, 3D Transform, Lighting and Bump Mapping Buttons 
  
These buttons are used for opening the appropriate 
palette, or activating it, if the palette was already opened. 
 
Click the desired button to open (or activate) the 
appropriate palette. 
 

Details:  
- When you open the palette, then the LED-like 

indicator on the appropriate button change its color from the 
dark red to the bright red. 

 
 
 
 
 
 

 
 

Caption 
 

As was mentioned, when we described the Work Area of the plug-in, 
the Caption contains three (3) menus (Main, Adjust and Window) 
and two (2) buttons (“?” and “X”). There are quite a few menu items 
under these menus. Some of them (Apply, Cancel, etc.) just repeat 
the existed and, as a result, already described controls, but some of 
the menus items may be found only under the appropriate menu and, 
therefore, they will be described below: 
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Undo/Redo (Main menu) 
 
These options let you undo the last action in the plug-in and then, if 
you decide that Undo was not a good idea, Redo (undo the prior undo) 
it. 
 
To use the Undo/Redo options of the plug-in, go under the Main menu 
and choose the appropriate menu item or use the Ctrl + Z (or Mac: 
Cmd + Z) shortcut. (See the list of Shortcuts below.) 

 
 

Details:  
- AV Bros. Page Curl Pro 2.2 has the multi-level Undo option. 
- Your actions may be undone only if they affect or may affect 

the image. For example, if you select the Enable Internal 
Shadows check-box in the Lighting (Advanced) palette, then 
this action may be undone. But if you select the Shadow Auto 
Rendering menu item under the Options button of the Main 
Preview, then this action cannot be undone, because this 
action does not affect the image. 

 
 
 

Save/Load Settings (Main menu) 
 

These features let you save the settings, with which you are happy for 
the one particular image, and, then use two (2) different ways (Load 
Settings [Relative] or Load Settings [Absolute]) to load these settings 
into the plug-in for applying to another image.  
 
To use these features of the plug-in, go under the Main menu and 
choose the appropriate menu item.  

 
Details:  
- AV Bros. Page Curl Pro 2.2 saves settings to the file with the 

extension AVCPS. 
- The Settings of AV Bros. Page Curl Pro 2.2 are the platform 

(Mac OS X/Windows) and document (in most cases) 
independent.  

Note! In some cases the settings, saved for the 
particular effect, will NOT let you obtain the same effect, 
when used with the new or changed document. The 
reason for this “issue” is the following: when you create 
the effect inside the plug-in, you may use the particular 
layer or channel of your document (or even an external 
file) as the page’s side(s) content and/or bump map(s). It 
is obvious that if you change the number (or order) of 
your document’s layers or channels or if you change the 
paths to the external files, because, for example, you 
have started working with the plug-in on another 
computer, then some of the settings will become invalid 
and as a result the re-created effect will not be the same. 

- The AVCPS file contains the data of both the absolute values of 
the parameters that you have specified and the relative values 
of these parameters. You can read about the difference 
between them in the Details of the Radius topic.  
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- When you apply AV Bros. Page Curl Pro 2.2, the plug-in saves 
the last used settings by itself. This lets you use these settings 
afterwards (Not only during the current session of the host, 
but after restarting it as well.), even if you did not save them 
by yourself.  

- When you start the plug-in, it automatically loads the last used 
settings using their relative values. But you can switch these 
settings to their absolute values by selecting the Reset 
Settings to the Last Used [Absolute] menu item under the 
Main menu. 

- AV Bros. Page Curl Pro 2.2 saves its settings in a file with the 
extension AVCPS and supports settings of the AV Bros. Page 
Curl Pro 2.0 and AV Bros. Page Curl 2.0 plug-ins (Files with 
the extensions AVCPS and AVCS relatively.), but not vice 
versa! In other words, neither AV Bros. Page Curl 2.0, nor AV 
Bros. Page Curl Pro 2.0 supports settings of AV Bros. Page Curl 
Pro 2.2. AV Bros. Page Curl Pro 2.2 does NOT support files 
with the extension PC12, which were used for saving settings 
in AV Bros. Page Curl 1.2. 

 
 
 

Reset Settings (Main menu) 
 
There are available three (3) different types of Reset Settings in AV 
Bros. Page Curl Pro 2.2:  

• Reset Settings to Last Used [Relative] 
• Reset Settings to Last Used [Absolute] 
• Reset Settings to Defaults. 

 
To use these features of the plug-in, go under the Main menu and 
choose the appropriate menu item.  
 

Details:  
- As was mentioned, when AV Bros. Page Curl Pro 2.2 

automatically saves the last used settings (See Save/Load 
Settings topic.), it uses by default their relative values. Use 
the Reset Settings to the Last Used option, for switching 
between Relative and Absolute values of those settings 
according to your needs. For example, as was mentioned in 
the Save/Load Settings topic, when you start the plug-in, it 
automatically loads the last used settings using their relative 
values. So, you can switch these settings to their absolute 
values by selecting the Reset Settings to Last Used [Absolute]. 

- When you select the Reset Settings to the Defaults option, you 
reset all settings of the plug-in to the settings, which were 
pre-defined by AV Bros. 

 
 
 

Copy Front Side Content to Back Side and vice versa (Adjust 
menu) 
 
These features let you copy the content of either side and paste it to 
another side.  
 



 AV Bros. Page Curl Pro 2.2  
 User Guide 
 

34 Controls, Features and Commands 

To use either feature, go under the Adjust menu and choose the 
appropriate menu item.  
 

Details:  
- Despite the fact that you can, without any doubt, define the 

side’s content using the Define button of this side, the Copy 
Front Side… feature is a convenient way to do this operation, 
especially when the content of the side is taken from the file. 

 
 

 
“?” (Help/About) Button 
 
By clicking on this button, you reach the Help and 
About menu items. 

 
 
 

“X” (Close) Button 
 

This button closes the plug-in and cancels all of your 
recent activity in the plug-in. 

 
 

 
 
 
 
 
 
 

Bends Window 
 
 

In the Bends window you can add, delete and manipulate 
the bends. 
 

General Details:  
• The maximum number of bends is 25. 
• Any bend is fully adjustable at any time within the plug-in session. 
• Add, Delete, Move Up and Down operations may be undone, in 

other words, you can use the Undo option that locates under the 
Main menu in the Main window or use the Ctrl + Z (or Mac: Cmd + 
Z) shortcut. 

 
 
 
Bends List 
  
The Bends List shows you (for further choosing) 
all existing bends (curls and/or folds) of the page. 
 
Select the desired bend in the list to make it 
active. If necessary, scroll the list. 
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Details:  
- Each bend has its unique name, such as Bend 01, Bend 02, etc. 

Next to the name is mentioned what type of bend has been used 
for this particular bend: Curl or Fold. 

- The selected (active) bend is marked with the blue color. 
 
 
 

Add and Add Copy Buttons 
 
Using these controls you can add the desired number 
of bends, which are either defaults or the same as the 
active bend. In the first case you use the Add button and in the second 
case – the Add Copy button. 
 
To accomplish the desired operation, you should click the appropriate 
button. 

 
Details:  
- Each time you add a new bend, it adds to the end of the bends list 

and becomes selected (active). 
- The page curl is the default bend. In other words, each time you 

add a new bend, you add the page curl. Of course, after that you 
can change the bend’s type to a fold using the Effects radio buttons 
in the Main window. 

- When you add a new bend by using the Add button, it will always 
be added with the default settings each time onto the same place – 
bottom right area of the page, irrespective of the page’s shape. In 
the Preview area of the Surface panel, you will see the color 
triangle, which represents this bend, in the bottom right corner. 
Once added, the new bend’s settings may be changed by using the 
appropriate controls located in the Surface panel. 

- Depending on the page’s shape and the settings of the existing 
bends, the new bend may be fully or partially added in the Conflict 
area. In this case the new bend will be fully or partially covered 
with the semi-transparent red colored overlay. (See How to Use 
Controls…>Main Window>Surface panel>Preview area.) 

- We recommend that you add new bends one by one, for more 
convenient operating with the new bend.  

- When you add a new bend by using the Add Copy button, then you 
add a new bend that has the same settings as the selected (active) 
bend. This means that a new bend will look exactly as the active 
bend and will be allocated onto the active bend place, rather than 
the bottom right area of the page as if you use the simple Add 
button. As a result, the new bend will always be covered with the 
semi-transparent red colored overlay and you need to change its 
parameters, if you want this new bend to really bend the page. 

 
 
 

Delete Button 
 
Using this control you can delete the unnecessary 
bends. 
 



 AV Bros. Page Curl Pro 2.2  
 User Guide 
 

36 Controls, Features and Commands 

To delete the unnecessary bend, you should select it first in the Bends’ list 
and then, click the Delete button. 

 
Details:  
- After deleting the bend, all the rest of the bends will be re-named 

to keep the continuous style of naming. For example: let’s say you 
have three (3) bends, therefore their names are – Bend 01, Bend 
02 and Bend 03. If you decide to delete Bend 02, you should select 
it and then, click the Delete button. In this case, Bend 03 will 
change its name to the new one: Bend 02. 

- To delete the bend, you can use not only the Delete button in the 
Bends palette, but the Delete button on your keyboard as well. Just 
do not forget to make the Bends palette active before using the 
keyboard. 

 
 
 

Up and Down Buttons 
 
Using these controls you can move the selected bend 
up and down in the bends’ list. 
 
Select the desired bend and then, click the Up button, if you want this bend 
to be moved up in the bends’ list or the Down button, if you want it to be 
moved down. 

 
Details:  
- Moving the bends up or down is necessary for changing the order of 

the bends. As was already mentioned (See Angle and Level topics.) 
the order of the bend determines whether the bend will be ousted 
by another bend, or the other way round - will oust other bends by 
itself. 

- When you move the bend up or down in the list, the look of the 
bent page in the Main Preview area may change. 

 
 
 
 
 
 
 
 

3D Transform Window  
 
 

In the 3D Transform window you can orient the page in 3D 
space and add, if desired, the perspective look to the 
oriented page. 
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3D Sphere, Spin slider and Flip Surface button 

The 3D Sphere lets you 
adjust the Azimuth and 
Altitude of the “central 
point” of the page. These 
parameters along with 
the central points’ spin, 
which is specified by the 
Spin slider, let you 
specify the orientation of 
the page in 3D space. 

Spin slider

Flip Surface

3D Sphere

Rotation Angles Display

The Flip Surface button 
lets you use the front 
hemisphere of the 3D 
space for orienting the 
page within the back 
hemisphere.  

To adjust the Azimuth 
and Altitude of the 
“central point” of the 
page, click the green 
(brown) square shaped 
plate on the hemisphere (This plate represents the page.) and drag it or 
enter the desired values into the edit boxes. 

To adjust the Spin of the “central point” of the page, drag the Spin slider or 
enter the appropriate value into the edit box. 

To flip the page’s surface, just click the Flip Surface button. 

Details:
- For the most convenient orientation the page in 3D space (Which is 

always a complicated task when you use the regular 2D user 
interface.) we have placed the special square plate 
on the 3D space’s hemisphere. This plate has (just 
like the page) two sides that are colored with green 
and brown colors. Different sides of the plate let you 
easily distinguish what side of the page (Front or 
Back) “looks” at you while orientating the page in 3D 
space. By default the plate has the green color. 

- The green colored plate corresponds to the front side of the page 
and the brown colored plate – to the back side of the page. 

- Each time you click the Flip Surface button, you change the side of 
the page that lies on the hemisphere and the plate 
changes from the green color to brown or vice versa. 

- To make the manipulation with the page even more 
noticeable, we have added the special black dot on 
the plate. By default, this dot is in the bottom right 
corner of the plate. When you use the Spin slider and/or Flip 
Surface button, the position of the dot changes.     

- You always operate only with one hemisphere – the front 
hemisphere. 

- If you need to orient the page within the back hemisphere (In this 
case you would see the page’s back side through the hemisphere, if 
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one assumes that the hemisphere is transparent.), then you should 
click the Flip Surface button. (This emulates the operation with the 
back hemisphere, though you still operate with the front 
hemisphere.) 

- When you click the Flip Surface button, the image on this button 
changes its color from black to red. 

- If the Real-Time Preview option is enabled, then any manipulations 
in 3D Transform palette are displayed in the Main Preview area. 

- There is the special cross-mark in the center of the front 
hemisphere, to which snaps the plate. This is designed for more 
convenient position the page strictly horizontally. 

- If you hold down the Shift button and only then, click on the plate 
and drag it, then the page (plate) will snap to the horizontal, 
vertical and 45 degree axes.  

- While preparing the complicated project that contains several bends 
and orienting this multi-bended page in 3D space, you may find 
(rarely) that it is difficult to obtain the desired orientation of the 
page and neither orienting the page on the hemisphere nor using 
the Spin slider helps. The problem has occurred because you have 
“lost” the correct position of the initial (front) page’s side. (The 
correct position means that the axe, around which you rotate the 
page when you use the Spin slider, directs vertically from the 
page’s front side.) The only solution is to make several steps back, 
(It is simple, thanks to the multi-Undo option of the plug-in.) then 
find the correct position of the front page and prepare the desired 
design again. Fortunately, this a very rare situation, thanks to the 
AV Bros. Page Curl Pro 2.2 convenient UI. 

 
 
 
Rotation Angles Display 
 
The Rotation Angles LCD-like display is ONLY targeted to show the values 
of the rotation angles in the standard (for 3D graphics) X,Y and Z-
coordinates. 
 
 
 
Perspective Level 
 
The Perspective Level control lets 
you specify the desired level of the 
perspective while orienting the 
page in 3D space. 
 
To adjust the Perspective Level, drag the Level slider or enter the 
appropriate value into the edit box. 
 

Details:  
- The range of the Perspective Level’s values is between 0 and 100. 
- The more the value of the Perspective Level, the more the 

“perspective look” you add to the page. 
- The point of the page, which has the maximum Z-coordinate (In 

other words is “closest” to you when you see the Main Preview 
area.) is used as the “initial” point for applying the perspective. As 
a result the less the Z-coordinate of the page’s point, the greater 
the perspective level it obtains. 
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- Even if you bend the page that is not oriented in the 3D space, you 
can adjust the perspective level. 

 
 
 
 
 
 
 
 

Lighting (Simple) Window 
 
 

When we described the Work area of the plug-in, we have mentioned that 
the Lighting palette has two (2) modes: the Simple and the Advanced 
modes. In the Simple mode you can only make the adjustments of the 
shading. 
 
To adjust the Shading of the page, drag the Shading slider or enter the 
appropriate value into the edit box. 
 
To switch the Lighting window to the Advanced mode, just click the Switch 
To Advanced Lighting Mode button. 
 

Details:  
- The range of the Shading’s values is between 0 and 100%.  
- The greater the value of the Shading, the more the page is shaded. 

 
 
 
 
 
 
 
 

Lighting (Advanced) Window  
 
 

The Advanced mode of the Lighting palette lets you obtain 
total control over the process of lighting the page.  
 

General Details:  
• In AV Bros. Page Curl Pro 2.2 we use the so-called 

Directional light. 
 

 
 

Light Sources Panel 
 

Here you can add the light sources to either Front and/or Back 
hemispheres and then, select (make active) any source either directly 
on the hemispheres or in the Light Sources list for further operations. 
You can also lock all Light Sources in order to prevent an accidental 
changing their position and existence.  
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To add the Light Source, choose both the desired hemisphere and the 
place on this hemisphere where you want to add the Light Source and 
double-click on this place. 

To select the existed Light 
Source, just click it right on 
the Light hemisphere or in the 
Light Sources’ list. 

Front and Back 
Hemispheres 

Light SourcesLight Sources list 

  Active

To delete the existed Light 
Source, select it and then, 
press the Delete button on 
the keyboard. 

To position the Light Source 
within the Light hemisphere, 
click and drag it. 

To lock all existed Light Sources, just select the Lock All check-box. 

Details:
- You can add up to twenty five (25) Light Sources to the Front 

and/or Back hemispheres. 
- You cannot delete ALL Light Sources - at least one (1) will 

remain in any case.   
- You can drag the existed Light Source within both hemispheres 

irrespective of the fact on which hemisphere it was initially 
placed. 

- To place the Light Source in the same place, but onto other 
Light hemisphere, switch the radio buttons (Front hemisphere 
to Back hemisphere or vice versa.) in the Active Light 
Direction area, which is described in the next topic. 

- If you need to delete the Light Source, you can also select it 
right on the hemisphere and then, right-click (Mac: 
Ctrl+click.) and choose the Delete menu item from the menu 
that will appear. 

- The Lock All option prevents either any displacement of the 
Light Sources and makes it impossible to add the new or 
delete the existing Light Source, but lets you adjust other 
parameters of the active Light Source. 

- To place the Light Source right on the center of the 
hemisphere, (This is the central point on the hemisphere’s 
surface with Azimuth equal to 0 degree and Altitude equal to 
90 degrees, rather than the physical center of the 
hemisphere.) you should select the Light Source and then, 
right-click (Mac: Ctrl+click.) and choose the Center menu 
item from the menu that will appear. 
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Active Light Panel 

Active Light Direction 

Active Light 
Hemisphere 

Virtual Object 
Sphere 

After selecting the Light 
Source, you can specify the 
direction of the Light Source 
or, in other words, the Light 
Source’s position on the Light 
sphere. 

To specify the direction of the 
Light Source do the following:  

• Move the mouse onto the Light 
hemisphere’s area. Once moved, the 
small ball that represents the Light 
Source will appear. 

“Light Source” 

• Click and drag this small ball to specify 
the desired direction of the Light Source 
or enter the desired values of the 
Azimuth and Altitude into the 
appropriate edit-boxes. 

To change the location of the Light Source from the Front Light 
hemisphere to the Back one or vice versa – select the appropriate 
radio button. 

Details:
- There is the specially prepared sphere (Virtual Object sphere) 

inside the Light sphere. The Active Light illuminates this 
sphere, so you can see the spot of the light, which vary 
depending on the Active Light’s parameters. And, though, this 
is not an accurate previewing of the Active Light, this spot lets 
you assume how the Active Light will light on the page. This is 
particularly relevant if the Real-Time Preview is disabled. 

- When you finish adjusting the direction of the Active Light, the 
small ball that represents the Light Source will disappear. This 
is specially designed for the most convenient previewing the 
spot of the Active Light. 

- When you adjust the direction of the Active Light by dragging 
the small ball over the Light hemisphere, the Active Light 
makes the same movements on the appropriate Light 
hemisphere in the Light Sources panel. 

Active Light Diffuse Reflection 

Here you can adjust the 
Diffuse Reflection of the 
Active Light. The controls that 
are available for this 
adjustment, work the 
following way: 



 AV Bros. Page Curl Pro 2.2  
 User Guide 
 

42 Controls, Features and Commands 

• Intensity: drag the slider to specify the desired intensity of the 
Diffuse Reflection of the Active Light or enter the desired value 
into the edit-box. 

• Color: click on the swatch to call the host’s Color Picker and 
choose the desired color of the Active Light’s Diffuse 
Reflection. 

• Affect: select the Front Side and/or Back Side check-box(es) 
to specify whether the Active Light affects either the Front 
and/or Back side of the page and as a result the presence of 
the appropriate Diffuse Reflection.   

 
Details:  
- The range of the Intensity values is between -500 and 500. 

The default value is 100. 
- When you adjust the parameters of the Active Light’s Diffuse 

Reflection (Color and Intensity), you can see the specified 
parameters on the Virtual Object sphere (See the Active Light 
Direction topic.) irrespective of the fact of whether or not the 
Affect check-boxes are selected or not. But if the Real-Time 
Preview option is enabled, then you can to see the result of 
your manipulation in the Main Preview too, but yet in 
consideration of the fact whether or not the Affect check-boxes 
are selected or not. 

- If the Intensity value is set to zero (0), then this means that 
the Diffuse Reflection does not exist at all and as a result, the 
Virtual Object sphere becomes black. (If, of course, the 
Intensity of the Active Light Specular Reflection is also set to 
zero or below zero.) As for the page, it also becomes black, 
but only if the Intensity of the Active Light Specular Reflection 
is set to zero too (or below zero) and if there are no other light 
sources with the positive Intensities of the Diffuse and/or 
Specular reflections. 

- The possibility to specify the “negative” Intensity (Means that 
the Intensity is below zero (0).) of the Diffuse Reflection lets 
you obtain interesting lighting effects. It is obvious that this 
option makes sense only if you have more than one light 
source. 

 
Active Light Specular Reflection 

 
Here you can adjust the 
Specular Reflection of the 
Active Light. The controls that 
are available for this 
adjustment, work the 
following way: 

• Intensity: drag the 
slider to specify the 
desired intensity of the Specular Reflection of the Active Light 
or enter the desired value into the edit-box. 

• Specular Exponent: drag the slider to specify the desired value 
of the Specular Exponent or enter the desired value into the 
edit-box. 

• Color: click on the swatch to call the host’s Color Picker and 
choose the desired color of the Active Light’s Specular 
Reflection. 
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• Affect: select the Front Side and/or Back Side check-box(es) 
to specify whether the Active Light affects either the Front 
and/or Back side of the page and as a result the presence of 
the appropriate Specular Reflection.   

 
 
Details:  
- The range of the Intensity values is between -500 and 500. 

The default value is 0. 
- The range of the Specular Exponent values is between 0 and 

1000. The default value is 50. 
- When you adjust the parameters of the Active Light’s Specular 

Reflection (Color, Intensity and Specular Exponent), then you 
can see the specified parameters on the Virtual Object sphere 
(See the Active Light Direction topic.) irrespective of the fact 
of whether or not the Affect check-boxes are selected or not. 
But if the Real-Time Preview option is enabled, then you can 
see the result of your manipulation in the Main Preview too, 
but yet in consideration of the fact whether Affect check-boxes 
are selected or not. 

- If the Intensity value is set to zero (0), then this means that 
the Specular Reflection does not exist at all and as a result, 
the Virtual Object sphere becomes black. (If, of course, the 
Intensity of the Active Light Diffuse Reflection is also set to 
zero or below zero.) As for the page, it also becomes black, 
but only if the Intensity Active Light Diffuse Reflection is set to 
zero too (Or below zero.) and if there are no other light 
sources with the positive Intensities of the Diffuse and/or 
Specular reflections. 

- The more the Specular Exponent, the less the diameter of the 
spot of the Active Light’s Specular Reflection and vice versa. 
The adjustment of the Specular Exponent is one of the 
methods of emulation of the different materials in 3D 
graphics: the less the diameter of the spot of the Active Light’s 
Specular Reflection, the more metallic is the material and vice 
versa.  

- The possibility of being able to specify the “negative” Intensity 
(Means that the Intensity is below zero (0). Sometimes also 
called: the subtracting intensity.) of the Specular Reflection 
lets you obtain interesting lighting effects just as in case with 
the Diffuse Reflection, only with the specifics of the Specular 
Reflection. It is obvious that this option makes sense only if 
you have more than one light source. 

 
 
 

Active Light Inner Shadow 
 
This part lets you enable the 
dropping of the Inner Shadow 
onto the page after bending 
this page and adjusting the 
parameters of this shadow. 
The controls that are available 
for this adjustment, work in the following way: 

• Enable check-box: select the check-box to enable dropping the 
Inner Shadow. 
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• Opacity: drag the slider to specify the desired value of the 
Opacity of the Inner Shadow or enter the desired value into 
the edit-box. 

• Size: drag the slider to specify the desired value of the Size of 
the Inner Shadow or enter the desired value into the edit-box. 

• Render Shadow button: click this button to render the Inner 
Shadow if the Shadow Auto Rendering option is disabled.   

 
Details:  
- The range of the Opacity values is between 0 and 100%. The 

default value is 75%. 
- The range of the Size values is between 2 and 100. The 

default value is 5. 
- You do not need to click the Render Shadow button if the 

Shadow Auto Rendering option is enabled, the inner shadow 
will be generated automatically. 

- If you have several Light Sources, then you can separately 
enable the Drop Inner Shadow option for each Light Source 
that you want to be used for dropping the Inner Shadow. 

- If your image contains the transparent areas, then the Inner 
Shadow will not be visible on these areas. 

 
 
 

Ambient Light Sub-Palette 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
This is the separate sub-palette of the Advanced Lighting palette for 
adjusting the ambient light. The controls that are available for this 
adjustment, work in the following way: 

• Intensity: drag the slider to separately specify the desired 
intensity of the Ambient Light for either side of the page or 
enter the desired value into the appropriate edit-box. 

• Color: click on the swatch to call the host’s Color Picker and 
choose the desired color of the Ambient Light for either side of 
the page. 

• “Chain” button: click this button if you want the parameters of 
the Ambient Light for both sides of the page to be changed 
simultaneously. 

• “Auto” check-boxes – select the particular check-box to enable 
the Ambient Light’s Auto-Adjustment option for the 
appropriate side of the page.   
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Details:  
- The range of the Intensity values is between 0 and 100%. The 

default value is 0%. 
- While lighting the page you change the color of page’s pixels. 

But in many cases it is very important to preserve some areas 
of the page from changing their colors. For example, if you 
bend a cut out part of the image, set the light source(s), drop 
the internal shadows, etc. and you need the non-bent area of 
this part to remain the same after applying the plug-in for 
further seamless cutting into the main image. This is the task, 
for which the Ambient Light’s Auto-Adjustment option is 
designed. When you enable this option, the plug-in’s engine 
adaptively adjusts the ambient light to keep the original color 
of any pixel of some “specific” areas of the page from 
changing their color while adjusting the light source(s). To 
become “specific”, the area should have its Altitude equal to 
90 degrees or, in other words, the area should be parallel to 
the background. And one more condition, which is necessary 
for the Ambient Light’s Auto-Adjustment option to work 
correctly – the light source(s) should be the white colored 
one(s) with the positive intensity. 

 
 
 
 
 
 
 
 

Bump Mapping Window  
 
 

In the Bump Mapping window you can specify whether you 
will texturize the page (by using the bump maps) and if you 
do, then specify what bump map you will use for this purpose and adjust 
its parameters. 
 

General Details:  
• Taking into account the fact that the effect of the texture is 

simulated, thanks to the Directional Light and the Bump Maps, you 
should leave at least one Light Source (Directional) that lights on 
the page’s side, which you want to texturize. 

• The Ambient Light, as the only source of the lighting, is not enough 
for texturizing the page. Moreover, even if there are one or more 
Directional Light Sources that light on the page, but the Intensity of 
the Ambient Light is much higher than the Intensity of other Light 
sources, then the texturizing effect (if present) will be decreased. 

• You may ask, why use the texturizing option of the plug-in, rather 
than the texturizer that is included in some hosts. Here is the 
answer: the built-in host texturizer (Even if it is a high-quality one.) 
cannot provide you with the correct result when you bend the 
image and orient it in 3D space. The reason is simple. The texture 
is the function of the appropriate lighting of the surface, therefore 
when you use the image that was texturized inside the host and 
then, you use our plug-in for bending and/or orienting the image in 
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3D space, you use this texturized image without the correct 
information about lighting. And only by using the internal 
texturizing option of the plug-in will it let you obtain the correct 
result. Therefore you are able to produce the highly realistic effect 
of the texture on the page that was bent and/or oriented in 3D 
space.

Level and Blur 

There are separate Level and Blur sliders for 
each side of the page in the Bump Mapping 
palette. These controls let you adjust the Level 
of the bump map and/or blur the bump map 
while texturizing the page. 

Drag the appropriate slider to specify the desired value of the parameter of 
the bump map for either side or enter the desired values into the edit-
boxes. 

Details:
- The range of the Level’s values is between 0 and 100. 
- The range of the Blur’s values is between 0 and 100 pixels. 
- The current settings of the lighting (Which you have specified in the 

Lighting (Advanced) palette.) determine whether dark areas of the 
bump map (Which is always a grayscale image.) are “responsible” 
for heights and the light areas – for depressions or vice versa. If 
you do not want to change the lighting settings, but need to switch 
depressions to heights or vice versa, then you can use the Invert 
Content (Black to white or vice versa.) button of the appropriate 
side. 

- The size of the texture’s virtual depressions and heights depends 
not only on the Level and Blur values, but on the current settings of 
the lighting as well. In other words, the look of the texture will be 
changed after changing the lighting settings, even if the Level 
and/or Blur parameters have not been changed. 

- By adjusting the Level parameter you emulate the changing of the 
flatness of the texture or, in other words, the size of the texture’s 
virtual depressions and heights. The more the value of the Level, 
the more the size of the texture’s virtual depressions and heights. 

- When you blur the bump map, you emulate the changing of the 
smoothness of the texture. The more the value of the blur, the 
smoother the texture. 

- When you preview the changes of the Level and Blur parameters in 
the Preview area of the Bump Mapping palette, then you should be 
aware that you will not notice the changes of the Level parameter, 
but you will definitely notice the changes of the Blur parameter. 

Invert, Flip Vertical and Horizontal Buttons 

There are separate Invert content, 
Flip Vertical and Flip Horizontal 
buttons for each side of the page in 
the Bump Mapping palette. Thes

Invert 

Flip Horizontal Flip Vertical e 
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buttons let you invert (black to white or vice versa) the content of the 
bump map for either side and flip the content of either side’s bump map 
either vertically or horizontally. 
 
Click the appropriate button to execute the desired action for either side. 
 
Define Buttons 
 
There is a separate Define button for each side of the page 
in the Bump Mapping palette. These buttons allow access to 
the menu for choosing the desired operation with the bump mapping. 
These operations are the following: 

• No Bump Mapping: means that no bump mapping will be applied to 
the page’s side, even if you have chosen a bump map before.  

• From Document Channel: means that after selecting this menu item 
the auxiliary Document Channels window will appear, so you can 
choose the desired channel for the content of the bump map. 

• From File – Tile: means that after selecting this menu item the 
standard open file dialog will appear and you will be able to choose 
the desired image from the file, which will be converted into the 
grayscale image and used as the bump map. For accomplishing this 
task, the image from the file will be tiled. 

• From File – Resize to Fit: the same procedure as above, except that 
the image from the file will be resized to fit the page.  

• Flip Vertical, Horizontal and Invert: these menu items just repeat 
the functionality of the appropriate buttons described above. 

 
Click the Define button of the appropriate side and after the menu appears, 
select the desired menu item. 
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How TOs 
 
 

elow you will find the general HOW TOs, which will help you to operate 
with the plug-in. In some cases, these HOW TOs will refer to the 

appropriate topic of the User Guide. In other cases you will be provided 
with the detailed instructions.  

 B
Note! We have in mind that AV Bros. Page Curl Pro 2.2 is 
properly installed under your image editing application (host). 
 
 
 

How to use AV Bros. Page Curl Pro 2.2 with the 
particular image?  

 
1. Start your host and open (or create) the document that contains the 
image with which you want to operate.  
 
2. Now go under the appropriate menu of your host and start AV Bros. 
Page Curl Pro 2.2. (In Adobe Photoshop it is menu Filter>AV Bros.>AV 
Bros. Page Curl Pro 2.2.) 

 
Note1: Be sure that the document is in the color mode 
supported by the plug-in (RGB, CMYK or Grayscale).  
Note2: By default, AV Bros. Page Curl Pro 2.2 uses the image, 
which is the content of the active layer of the current document, 
as the Front side of the page and the host’s background color as 
the content of the Back side of the page. But then, when you 
start the plug-in next time, the content of either side will depend 
on the last used settings. 

 
3. Use the controls of the plug-in to create the desired effect. Read the 
User Guide to learn how to use these controls. 
 
  

 

How to make the page fold effect, rather than the page 
curl (or vice versa)? 

 
1. To change the type of the effect just click the appropriate radio-button 
(e.g. Fold) on the Surface panel of the plug-in’s Main window.  
 
2. Use the controls of the plug-in to create the desired effect. Read the 
User Guide to learn how to use these controls. Pay attention to the Details. 
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How to make the curled (folded) part of the page to be 
beneath the main part of the page? 

 
1. Click the Down radio-button on the Surface panel of the plug-in’s Main 
window.  
 
2. Use the controls of the plug-in to create the desired effect. Read the 
User Guide to learn how to use these controls. Pay attention to the Details. 

 
 
 

How to make the bended (curled and/or folded) part of 
the page to be outside the document canvas? 

 
1. Taking into account the fact that while bending (curling or folding) the 
page in AV Bros. Page Curl Pro 2.2, you can preview the page entirely, 
regardless of whether it has been clipped by the canvas or not, we 
recommend that you enable the Show Clipping Zone feature to have an 
idea of whether your image is clipped or not and if yes, then how it is 
clipped.  
 
2. If you have made this kind of adjustments, in which the bended (curled 
and/or folded) part(s) of your image is outside the canvas, then you have 
two possibilities to obtain the desired design in your host:  
 
 

- You can click the Apply button to make the plug-in remember the 
current settings (Another solution is use the Save Settings feature.) 
and then, when you obtain the created image clipped in your host, 
simply Undo the operation in the host. Then extend the canvas, so 
the bent image has enough space to avoid being clipped (Just be 
sure that the source image is in the separate layer, rather than in 
the Background layer or any other layer with the protected 
transparency.) and apply the plug-in to the source image one more 
time. 

 
- Once you are happy with the effect, use the Export feature of the 

plug-in. Then close the plug-in and open (import) the file that you 
just exported. Read the How to Use the Controls, Features and 
Commands>Main Window>Executing Area>Export Button topic to 
learn more about the Export option. 

 
 

 

How to accurately position the bended part of the image 
from the active layer with regard to other images 
(layers’ content) of the current document? 

 
AV Bros. Page Curl Pro 2.2 has an extremely helpful feature that lets you 
use various backdrops for the Main Preview area. Thanks to this feature it 
is possible to easily solve this task. Read the How to Use the Controls, 
Features and Commands>Main Window>Main Preview>Using the Backdrop 
topic to learn more. 
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How to place an image onto the back side of the page? 
 
AV Bros. Page Curl Pro 2.2 provides the user with powerful management 
and control of the content of the page’s sides. Read the How to Use the 
Controls, Features and Commands>Main Window>Content Panel topic to 
learn more. 
 
 
 

How to obtain the transparent area under the bent part 
of the page? 

 
The transparent area under the bent (curled and/or folded) part of the 
page is generated automatically, just be sure that the active layer is not 
the background layer or the layer with the protected transparency.  
 

Note! If the active layer is the background layer or the layer with 
the protected transparency, then the area under the bent part 
will be filled with a background color that is specified in your 
host. 

 
 
 

How AV Bros. Page Curl Pro 2.2 operates with the 
selection? 

 
1. If there is a selected area in the image then, when you start AV Bros. 
Page Curl Pro 2.2, it operates solely with this area. When you apply the 
plug-in, you obtain the result within the selection boundary in the host. It 
should be understood that depending on the plug-in settings, the part of 
the bent image may be clipped by the selection as soon as you obtain the 
result inside the host. 
 
2. If you do not want the resulting image to be clipped by the selection, 
then you should do one of the following:  
 

- Use the Export feature of the plug-in. Then close the plug-in 
and open (import) the document (.PSD file) that you just 
exported. This document will contain the bent, but not clipped 
image. 

- You can copy the content of the selected area to the new layer 
(Just do not forget to deselect.) and apply the plug-in to it. 
Although, you should be aware that this solution may not be 
acceptable in some cases. (Not because of any restrictions 
from the plug-in side, but because of the design issues.) 

 
Note! Here we want to repeat the statement from the Details of 
the Showing the Clipping Zone topic: The Clipping Zone shows 
the bounds with which your host provides the active layer, 
irrespective of the presence of the selection in the active layer. 
In other words, despite the presence of the selection that may 
clip the curled (folded) page, you will not see any changes in 
displaying the Clipping Zone in the Main Preview area just as if 
there is not any selection. 
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How to bend (curl and/or fold) the image several 
times?  

 
1. There is the special option in AV Bros. Page Curl Pro 2.2 that lets you 
add several bends to the image. (Read the Bends topic of the User Guide.) 
Using this option is the best way to bend the page several times. Moreover, 
this option lets you bend the page several times within one session of the 
plug-in.   
 
2. If in the statement: “The possibility to bend the page several times 
within ONE session of the plug-in”, the word “one” is not critical, then, in 
some cases, you can use the solution that was prepared for the regular 
version of the plug-in (AV Bros. Page Curl 2.0). Here is that solution: 
thanks to the fact that AV Bros. Page Curl 2.0 operates with the arbitrary-
shaped images, you can apply the plug-in several times to previously non-
curled (folded) areas. Just call the plug-in several times. To avoid artifacts, 
be sure that the next curling (folding) does not affect the previously curled 
(folded) part of the page.  
 

Note! Using method #2 is quite limited when you use AV Bros. 
Page Curl Pro 2.2. This is not because of the limitation from the 
plug-in side, but because method #1 provides much more 
powerful possibilities. The point is that when AV Bros. Page Curl 
Pro 2.2 operates with the multi-bent page (method #1), the 
plug-in’s engine calculates the correct mathematical surface each 
time for each bend. But if you use method #2 and call the AV 
Bros. Page Curl Pro 2.2 to already bended image, then the plug-
in (Irregardless of whether it is the regular or the Pro version.) 
uses the bent page as a regular image and as a result, the bent 
part is just the content of this image, rather than a 
mathematically correct surface. Therefore, you cannot correctly 
bend an image in many situations  when using method #2 (While 
orienting in 3D space, dropping internal shadows, texturizing, 
etc.), though, in fact it is correct and may provide absolutely 
affordable results in some simple cases.                     
 
 
 

How to make the “non-complete” curl? 
 
It is possible to prepare the “non-complete” curling effect, thanks to the 
Limit of the turning - the unique feature of AV Bros. Page Curl Pro 2.2. To 
prepare such an effect, do the following: 
 
1. Select the page curl, for which you want to specify the Limit of turning, 
to make it active. (You can select the desired page curl either in the list of 
the bends in the Bends palette or right in the preview area of the Surface 
panel. By the way, if you have started the plug-in for the very first time, 
then there is only one default bend – page curl, which is already active. 
Please read the topics How to Use the Controls, Features and 
Commands>Main Window>Surface Panel>Preview Area and How to Use 
the Controls, Features and Commands>Bends Window to learn more about 
the controls. Pay attention to the Details.) 
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2. Select the Limit check box and specify the desired value of the Limit of 
the turning. Then adjust the parameters of the page curl effect (Angle, 
Level, etc.) to obtain the desired look of the “non-complete” curling effect. 

 
 
 

How to orient the page in 3D space? 
 
In AV Bros. Page Curl Pro 2.2 you can orient the image (By the way not 
only for further bending! See the How to use the plug-in in non-standard 
way topic.) in two ways:  
 
1. Using the controls on the 3D Transform palette. Be sure that the palette 
is active. If it is not, then click the 3D Transform button in the Main window 
to activate this palette. Please read the topic How to Use the Controls, 
Features and Commands>3D Transform Window to learn more about the 
controls. Pay attention to the Details.  
 
2. If the Real-Time Preview option is enabled, then you can orient the page 
in 3D space right in the Main Preview area. Read the following topic: How 
to Use the Controls, Features and Commands>Main Window>Main 
Preview>Preview Area. Pay special attention to the Details. 

 
 
 

How to texturize the page? 
 
In AV Bros. Page Curl Pro 2.2 you can texturize either side of the page by 
using the grayscale images (called Bump Maps). As a Bump Map you can 
use either your document’s channels or any file.  
 
1. Be sure that the Bump Maps palette is active. If it is not, then click the 
Bump Maps button in the Main window to activate this palette.  
 
2. Define the desired bump map, which will be used for texturizing the 
appropriate page’s side, using the Define button.  
 
3. Use the controls of the palette to operate with the chosen bump map. 
Please read the topic How to Use the Controls, Features and 
Commands>Bump Mapping Window to learn more about the controls. Pay 
attention to the Details. 

 
 
 

How to drop an internal shadow? 
 
In AV Bros. Page Curl Pro 2.2 you can let either light source drop the 
internal shadow. This amazing feature provides the bent page with the 
extremely realistic look. To drop the internal shadow(s) do the following: 
 
1. Be sure that the Lighting (Advanced) palette is active. If it is not, then 
click the Lighting button in the Main window to activate this palette. (If you 
are using the plug-in for the very first time, you also need to click the 
Switch To Advanced Lighting Mode button, which is in the bottom of the  
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Lighting (Simple) palette. Do the same if the Lighting (Simple) palette was 
the last used lighting palette.) 
 
2. In the Lighting (Advanced) palette, choose the Light Source that you 
want to drop the Internal Shadow. (Choose it either in the list of Light 
Sources or right on the appropriate Light hemisphere.) Enable dropping 
internal shadows option for chosen light source. (If you have several light 
sources, then you can enable this option for either of them.) Then adjust 
the parameters of the Inner Shadow(s) by using the appropriate controls. 
Read the following topics: How to Use the Controls, Features and 
Commands>Lighting (Advanced) Window>Light Sources Panel and How to 
Use the Controls, Features and Commands>Lighting (Advanced) 
Window>Active Light Panel>Active Light Inner Shadow. Pay special 
attention to the Details. 

 
 
 

How to use AV Bros. Page Curl Pro 2.2 in a 
“nonstandard” way? 

 
AV Bros. Page Curl Pro 2.2 is not only the unrivalled page bender, but also 
has a few powerful options (Orientation in 3D space, Texturizing and 
Lighting) and thanks to them the plug-in can be used as a high-quality 
Texturizer, Lighting effects creator and for orientating images in 3D space. 
This is what we call “Using the plug-in in a nonstandard way”.  
So, you can use these options of the plug-in for any image even when you 
do not need to bend it. Just open the image that you want to texturize, etc. 
inside your host, start our plug-in and use its powerful possibilities.  
To learn more about either option, read the appropriate topic of this User 
Guide. 
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Keyboard Shortcuts 
 

Apple Mac OS X keyboard abbreviations: 
Command – Cmd 
Shift – Shft 

 
PC Windows keyboard abbreviations: 

Control – Ctrl 
Shift – Shft 

 
  
 

Keyboard Shortcut 
Command 

Mac OS X Windows 
 
Toggle Simple Lighting Palette 
 
Toggle Advanced Lighting Palette 
Toggle Ambient Light Palette 
 
Toggle 3D Transform Palette 
 
Toggle Bump Mapping Palette 
 
Toggle Bends Palette 
 
Undo 
Redo 
 
Save Settings 
Load Settings 
 
Export Render Result as PSD 
Export Render Result as PNG 
 
Toggle Show Clipping 
 

 
Cmd+E  
 
Cmd+J 
Cmd+Shft+J 
 
Cmd+T  
 
Cmd+M 
 
Cmd+B 
 
Cmd+Z 
Cmd+Y (Cmd+Shft+Z) 
 
Cmd+S 
Cmd+L 
 
Cmd+Shft+S 
Cmd+Shft+E 
 
Cmd+H 

 
Ctrl+E  
 
Ctrl+J 
Ctrl+Shft+J 
 
Ctrl+T 
 
Ctrl+M 
 
Ctrl+B 
 
Ctrl+Z 
Ctrl+Y (Ctrl+Shft+Z) 
 
Ctrl+S 
Ctrl+L 
 
Ctrl+Shft+S 
Ctrl+Shft+E 
 
Ctrl+H 
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